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1

Introduction to MACHU-GIS

MACHU-GIS 2.4 has been developed within the framework of the EU Culture 2000
project MACHU (Managing Cultural Heritage Underwater). The main purpose of
MACHU is to open up the information of the cultural underwater heritage to
scientists, decision makers and the general public. The MACHU-GIS is to address
scientists as well as policy makers. The public will be addressed through the MACHU
website. For information on the MACHU project and the specific place of the GIS
system within the project see: www.machuproject.eu.
The MACHU-GIS has been developed on MapViewer internet version 2.4, the
standard web-GIS application of Rijkswaterstaat, the executive arm of the Dutch
Ministry of Infrastructure and Environment. The MapViewer is a web application
enabling users to compose maps, for example for presentations or reports. Carrying
out simple (spatial) analyses is also possible. A large number of geographic files can
be used to compose the maps, in the course of which any combination is possible.
For additional information on backgrounds, related applications and current projects
in connection with the MapViewer, please contact Rijkswaterstaat at
https://www.rijkswaterstaat.nl/en/contact.
Within MACHU-GIS it is possible to combine relevant data for managing the cultural
underwater heritage from different sources. MACHU-GIS is originally developed to
combine archaeological and historical data of several EU partners with the
information of the surroundings (such as geophysical, chemical, sedimentation and
oceanographic information), possible threats in the short term (such as erosion,
works significantly developing the infrastructure, exploitation of the sea bottom,
fishery) and possible threats in the long term (such as the increasing erosion due to
the climate variation and chemical deterioration), as well as relevant legislation.
Map layers in the MACHU-GIS are presented through web services (WMS), some of
which have standard data formats as defined during the MACHU-project. The web
services are combined and grouped in to themes and layers by the administrator
using an Administration Module. Each layer contains one or more sub layers,
representing data from a specific source (Web Map Service), e.g. country
representative. Users can access the information related to these map layers or
create their own custom selection of map layers.
The application contains information in English. Information is based upon INSPRIRE
formats and OCG standards to the greatest possible extent.
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2

Zooming in on the map

Description
Zooming in on the map can be done in various ways. With each way of zooming a
new map is fetched with visible map layers in conformity with scale dependency as
laid down in the definition file on which the map is based.
Actions
Zooming in by means of clicking:

 Activate the displayed button and click in the map to zoom in.
The point of clicking becomes the centre from which zooming occurs.
Zooming in by means of drawing a frame:

1 Activate the displayed button.
2 Drag a frame in the map keeping the left mouse button pressed in.
The selection becomes the point from which zooming occurs.
Zooming in by means of the slider in the map:

 Move the displayed slider up to zoom in.
Zooming in by means of the plus (+) button above the slider:
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 Click the displayed button to zoom in..
Zooming in by means of scrolling with the mouse:
 Position the mouse in the map and scroll up.
The position of the mouse becomes the centre from which zooming occurs.
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3

Zooming out on the map

Description
Zooming out on the map can be done in various ways. With each way of zooming a
new map is fetched with visible map layers in conformity with scale dependency as
laid down in the definition file on which the map is based.
Actions
Zooming out by means of clicking:

 Activate the displayed button and click in the map to zoom out.
The point of clicking becomes the centre from which zooming occurs.
Zooming out by means of drawing a frame:

1 Activate the displayed button.
2 Then drag a frame in the map keeping the left mouse button pressed in.
The selection becomes the point from which zooming occurs.
Zooming out by means of the slider in the map:

 Move the slider down to zoom out.
Zooming out by means of the minus (-) button beneath the slider:

Page 12 of 159

Help text MACHU-GIS | 22 2 2013

 Move the slider down to zoom out.
Zooming out by means of scrolling with the mouse:
 Position the mouse in the map and scroll down.
The position of the mouse becomes the centre from which zooming occurs.
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4

Zooming to the starting map extent

Description
The starting map extent is stored in a map settings file. When login has occurred,
the start map settings are loaded and zooming to the starting map extent occurs.
This function is intended to return to the starting map extent (after the map extent
has been adapted).
It is possible to open a different map-settings file. When a different file is opened,
zooming occurs to this map extent.
Actions

 Click the displayed button to zoom to the starting map extent.
The starting map extent is displayed.
Also view:
Opening map settings
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5

Previous and next map extent

Description
Each zoom or move action to the map is stored as a map extent. The previous and
next buttons enable a step forward or a step back in these map extents. This is
comparable with the ‘undo’ and ‘redo’ functionalities.
Actions

 Click the arrow to the left to view the previous map extent.

 Click the arrow to the right to view the next map extent.
This functionality applies only when a previous map extent has been viewed first.
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6

Moving the map (panning)

Description
It is possible to move (or pan) the map in various ways. The map can be picked up
or moved by means of buttons with a fixed value. Besides, there is a navigation
map representing the large map. The navigation map contains a red frame (the size
of the frame depends on the scale level) which can be dragged to the desired
position in the map.
Actions
Moving by means of grabbing and dragging the map:

1 Activate the displayed button.
2 Click in the map and keep the left mouse button pressed (the map is ‘picked up’
by the mouse now).
3 Set the mouse in motion and the map is moved in the direction indicated.
4 Release the left mouse button to confirm the new position.
The map can only be moved within the limits of the frame.
Moving by means of the panning buttons in the map:

 The display contains four buttons enabling the map to be moved.
The button indicates the direction into which the map will move.
Also view:
 Overview or navigation map
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7

Overview or navigation map

Description
The overview or navigation map represents the total map at a larger extent. The
position of the map can be determined with the use of the red dotted frame or the
red cross. The red frame changes into a red cross when zooming in far into the map
has occurred. The overview or navigation map can be folded away by clicking the
arrow (pointing down) on the bottom right. The map can be unfolded again by
clicking the arrow (pointing up) on the bottom right.
In MACHU-GIS the maximum extent is set to global. The extent will increase when
zooming in to the map, but will continue to represent the total map on a larger
scale.

Action
The overview or navigation map contains a red dotted frame or red cross.
 Drag the red dotted frame or the red cross to the desired position.
The map immediately moves along when the frame is dragged.
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8

Measuring and displaying distance

Description
The distance between 2 or more points can be measured within the map.
Action

1 Click the displayed button to activate the measuring function.
2 Then place at least 2 points by clicking the desired positions in the map.
A line appears between the points applied.

The entire distance between the points and the distance of the latest segment are
displayed as demonstrated in the illustration.
 Double-click in the map to stop the measuring session.
Clicking in the map again starts a new measuring session. The measuring function
remains active as long as no other button is activated.
Also view:
Measuring and displaying area
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9

Measuring and displaying area

Description
A polygon can be drawn in the map. The area of this polygon is displayed.
Action

1 Click the displayed button to activate the measuring function.
2 Then place at least 2 points by clicking the desired positions in the map.
A polygon appears between the points applied.

The area of the polygon drawn is displayed as demonstrated in the illustration.
 Double-click in the map to stop the measuring session.
Clicking in the map again starts a new measuring session. The measuring function
remains active as long as no other button is activated.
Also view:
Measuring and displaying distance
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10

Displaying map information

Description
Each map contains map layers which in their turn usually contain feature
information. This function enables the feature information to be retrieved.
In MACHU-GIS the function acts on all visible map layers or on a single activated
theme, layer or sub layer. Retrieved information is displayed on sub layer level.
Action

1 Click the displayed button to activate the Identify function.
2 Optionally activate a theme, layer or sub layer to narrow the list of results.
3 Then click an object in the map whose information must be retrieved.
In MACHU-GIS a picture of a pin indicates the location of the click.
A window pops up containing the information available on the indicated objects of
the active map layer or, if no map layer is active, of all visible map layers. The
information is displayed in the shape of a table with the attribute names as column
headings followed by the corresponding attribute values of the result.
Also view:
Retrieving meta information
Activating a map layer
Introduction to MACHU-GIS
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11

Switching themes, layers en sub layers on and off

Description

The table of contents (left of the map) contains all map layers that can be made
visible within the map.
Clicking a plus-symbol in front of a theme or layer will unfold the hidden list of
layers or sub layers below. Clicking a minus-symbol will hide them again.
Switching the visibility of themes. layers or sub layers on or off is done by ticking
the checkboxes present in the table of contents. Ticking a theme on makes all the
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underlying layers and their sub layers visible. Ticking a layer on makes all
underlying sub layers visible. And vice versa.
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12

Indication of visibility of sub layers in layers and themes

The theme shows whether or not underlying layers and sub layers are visible:
Theme with a small folder and red icon means: underlying layers are not visible.
Green icon: all the layers and sub layers are visible.
Theme without icon added to the small folder: some layers or sub layers are visible,
others are not.
The same applies on the level of the map layers.

Action
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 Tick the name of sub layer, map layer or theme to switch all the underlying layers
off or on respectively.
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13

Activating a map layer

Description

Activating a map layer makes it possible to carry out actions related to the map
layer in question.

It is possible to activate one single sub layer, a complete layer
or an entire theme. Its background lightening blue indicates
that a map layer is active. The activation is switched off again
by clicking the map layer once more.
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The possibility of using an activated sub layer, layer or theme depends upon the
function that is carried out.
Action
 Activate a layer,

sub layer or theme from the list by clicking a layer.

The following functionalities can be carried out on an active layer.
Also view:











Selecting by means of clicking
Cancelling a selection
Selecting with the use of a rectangle
Selecting by drawing a line
Selecting by drawing a polygon
Selecting inside another geographical feature
Query builder
Using the selection table
Editing labels
Deleting labels
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14

Map layer visible in the legend

Description
The elements of a

sub layer

are always displayed in the legend.

Action


Click the Legend tab to display the legends of the visible sub
layers.

Also view:
 Displaying active elements of the legend
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15

Notification of visibility of scale-dependent sub map layer

Description
Map layers have been digitalized with a particular scale (accuracy), as a result of
which they have a corresponding application scale. Consequently in most cases it is
unadvisable to use for example a topographic map 1: 25,000 on a scale of 1:
60,000. Making use of a topographic map 1: 50,000 is better in this case. Against
this background, in combination with performance reasons, a minimum and/or a
maximum scale has been defined for some files. The map layer concerned is not
visible outside the defined scale. In the table of contents, this is indicated by the
name of this map layer in red and the exclamation mark depicted with the map
layer name.
In MACHU-GIS spatial resolution is defined in the sub layer.
Action
No action
Also view:
 Retrieving scale information on a map layer
 Zooming to the maximum scale
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16

Adjusting the transparency of a map layer

Description
A map is composed of map layers. These map layers are frequently positioned on
top of one another. The sequence of the map layers is shown in the table of
contents. A map layer ‘X’ will be placed above another layer ‘Y’ in the map, when
the map layer ‘X’ is placed below map layer ‘Y’ in the table of contents. A map layer
may be invisible because of another map layer on top of it. The transparency can be
adjusted for each map layer by means of a slider.
In MACHU-GIS transparency can be adjusted on the layer level.

Action
1 Activate a layer.
2 Use the displayed slider to adjust the transparency of the map.
The map layer transparency changes immediately, which is visible in the map.
Also view:
Activating a map layer
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17

Adding a new theme, layer or sub layer

Description
All layers added by the administrator, can be found in the table of contents when
logging in to MACHU. It is possible to customize the table of contents by creating
new themes and layers and adding sub layers. Sub layers, derived from a Web Map
Service (WMS) can be selected from the administrator’s layer list or derived from an
external Web Map Service by entering its Uniform Resource Locator (URL).
Actions
Adding a new theme:
1 Press the right mouse button and click on Machu Layers in top of the table of
contents.
2 Select the Add theme option that will appear to open the ‘Add Theme’- popup
window.
3 Add a new theme name in the text box after ‘Theme:’.
4 Click the Add button.
5 Click on the new added theme in the table of contents to move it to a desired
location within the table of contents.
Adding a new layer:
1 Add the layer directly when creating a new theme by adding a layer name after
‘Layer’ in the ‘Add theme’ popup window.
2 Click on the new added layer in the table of contents to move it to a desired
location within the theme.
Or
1 Press the right mouse button and click on the theme in the table of contents
where the layer is to be added
2 Select the ‘Add layer’ option that will appear to open the ‘Add (favourite)’ popup
window
3 Add a new layer name in the text box after ‘Layer:’
4 Click the Add button.
5 To view the new added layer in the table of contents, press the minus symbol in
front of the theme to unfold the list of layers.
6 Click on the new added layer in the table of contents to move it to a desired
location within the table of contents.
Adding a new sub layer from the administrator’s layer list:
1 Press the right mouse button and click on the layer in the table of contents where
the sub layer is to be added
2 Select the ‘Add sub layer’ option that will appear to open the ‘Add (favourite) map
layer’ popup window
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3 Select the ‘Select’ tab. A list of available web map services provided by the
administrator is presented here. Each service contains one or more sub layers
that can be add to, or are already present in, the table of contents.
4 Click the map of the desired service. The list with available sub layers unfolds
5 Click one sub layer. A preview of the file appears in the right window of the popup
6 Click the Add button to add the sub layer to the map layer.
7 Repeat previous steps to add more sub layers or click the Close button to close
the pop-up and to return to the map.
8 To view the new added sub layer in the table of contents, press the minus symbol
in front of the layer to unfold the list of sub layers.
9 Click on the new added sub layer in the table of contents to move it to a desired
location within the layer.
Adding a sub layer from an external web map service:
1 Press the right mouse button and click on the layer in the table of contents where
the sub layer is to be added.
2 Select the ‘External’ tab.
3 Enter the URL of the web map service in the text box, after ‘URL:’.
4 Click the Connect button. A preview of the file appears in the right window of the
pop-up
5 Click the Add button to add the sub layer to the layer.
6 Click the Close button to close the pop-up and to return to the map.
7 Repeat previous steps to add more sub layers or click the Close button to close
the pop-up and to return to the map.
8 To view the new added sub layer in the table of contents, press the minus symbol
in front of the layer to unfold the list of sub layers.
9 Click on the new added sub layer in the table of contents to move it to a desired
location within the layer
Adding Research Images
In MACHU-GIS it is also possible to add images from an individual research
represented by the features in the Research Area layer. To do this, open the
attribute table of a Research Area sub layer and click on the ‘Add’-button displayed
in the ‘Image’ column. This button will only be displayed if an image is available.
After clicking the ‘add’-button, the image will be added into a Theme/layer called
‘Research Images’. This Theme/layer will be created if the first image is added this
way to the table of contents.
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Also view:
Displaying map information
Switching themes, layers and sub layers on and off
Changing the sequence of a map layer
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18

Deleting a

theme, layer or sub layer

Description
A theme, layer or sub layer can be deleted from the list of map layers. As a
result the layer is no longer visible in the map.
Action

1 Press the right mouse button and click on the theme, layer or sub layer in the
table of contents
2 Select Delete.
Also view:
 Activating a map layer
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Zooming to the maximum scale

Description
Map layers have been digitalized with a particular scale (accuracy), as a result of
which they have a corresponding application scale. Consequently in most cases it is
unadvisable to use for example a topographic map 1: 25,000 on a scale of 1:
60,000. Making use of a topographic map 1: 50,000 is better in this case. Against
this background, in combination with performance reasons, a minimum and/or a
maximum scale has been defined for some files. The map layer concerned is not
visible outside the defined scale. In the table of contents this is indicated by the
display of the name of this map layer in red and the exclamation mark depicted with
the layer name.
The scales defined can be retrieved using the

scale information button.

When a map layer has a defined maximum scale, ‘Zooming to maximum scale’
zooms to this maximum scale and the map layer becomes visible. In the table of
contents this is indicated by the name of the layer displayed in black. It may occur
that the map layer, after zooming, is not displayed on screen yet. In this case the
map layer is a large-scale map layer (for example: 1:10,000). In this case zooming
occurred to a location where the map layer does not contain information. The map
can be moved to a different area using the panning functions. The minimum
and the maximum scales are fixed and cannot be adapted.
In MACHU-GIS this functionality is active only on a sub layer level.
Action

 Click the displayed button to zoom to the active map layer.
If a maximum map scale has been defined for the active map layer, zooming occurs
to the maximum scale.
In MACHU-GIS this functionality is active only on a sublayer level.
Also view:
 Retrieving scale information on an active map layer
 Notification of the visibility of a scale-dependent map layer
 Moving the map (panning)

Page 34 of 159

Help text MACHU-GIS | 22 2 2013

20

Using the attribute table

Description
The attribute table contains attribute information of the active map layer. Additional
functionalities are available which are related to the attribute table. These
functionalities become available as soon as the attribute table is opened.
In MACHU-GIS this functionality is active only on a sub layer level.
NOTE: If a selection is performed on the map layer, the attribute table will still show
all features available in the sub layer, but the additional function will be performed
on the selected set of features! Use the remove selection button at the select tab to
delete the selection.
Actions

1 Activate a sub layer.
2 Click the displayed button at the bottom of the table of contents.
A window pops up containing the attribute information (in table shape) of all
features within the active sub layer.
Highlighting object(s)

1 Select one or more rows (simultaneously press the 'Shift' or ‘Crtl’ key when
clicking more rows) to create a sub selection.
1 Click the displayed button.
The selected features are highlighted in the map.
Zooming to a selection

1 Click the displayed button.
Zooming occurs to all features. However if a sub selection is created, zooming will
occur only to the selected set of features.
Exporting to an Excel file
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1. Click the displayed button.
2. Click 'Save' or 'Open' when the request appears to download the Excel file.
The Excel file contains the same values as the attribute table. If a sub selection is
created, only the rows of the sub selection will be exported.
Deleting a sub selection

If a sub selection is present, it can be deleted.
1 Click the displayed button.
The sub selection is removed from the table. The selection remains unchanged.
Sorting records
It is possible to sort the records of the selection table.
1 Select an attribute header. Once a header is selected, an arrow is displayed after
the attribute name and a dropdown list with additional options is added.
1 Click on the arrows after the attribute name to order the record ascending or
descending or
1 Click the dropdown list and select the option Sort Ascending or Sort descending
Determine the visibility of attributes
It is possible to determine which attributes in the table are visible.
1 Select an attribute header. Once a header is selected, an arrow is displayed after
the attribute name and a dropdown list with additional options is added.
1 Click the dropdown list and select the option Columns to open a list of available
attributes.
1 Switching the visibility of attributes on or off is done by ticking the checkboxes in
front of each attribute
Also view:
 Using the selection table
 Cancelling a selection
 Activating a map layer
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21

Retrieving scale information on an active map layer

Description
Each map layer has a minimum and a maximum scale level. The map layer is only
visible when the scale of the map is between the minimum en the maximum scale
level of the map layer.
In MACHU-GIS this functionality is active only on an active sub layer level.
Action

1 Activate a sub layer.
2 Click the displayed button at the bottom of the table of contents or the legend.
A window pops up containing the scale information of the selected map layer.
Also view:
Notification of visibility of scale-dependent sub map layer
Activating a map layer
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22

Retrieving meta information

Description
All map layers contain meta information.
In MACHU meta information can only be retrieved on a sub layer level.
Action

1 Activate a sub layer.
2 Click the displayed button at the bottom of the table of contents or the legend.
A window pops up containing the meta information of the selected

sub

layer.

In MACHU-GIS it is also possible to retrieve meta information from individual
research datasets represented by the features in the Research Area layer. To do
this, open the attribute table of the Research Area sub layer and click on the
metadata-button of a research.

Also view:
 Activating a map layer
 Displaying map information
 Meta data
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Changing the sequence of map layers

Description
The sequence of the map layers in the table of contents is related to the visibility in
the map. The upper map layer in the list is the upper the map layer in the map as
well. Consequently certain map layers may occur in the map although they are not
visible because another map layer is on top of them. Adapting the sequence of the
map layers makes underlying layers visible again. The transparency of a map layer
can also be adapted to make underlying map layers visible.
Because of the layered arrangement of the maps in this application, abovementioned procedure applies only for sub layers within their own layer, layers within
their own theme and complete themes within the table of contents. So sub layers
cannot be moved to other layers or other themes and layers cannot be moved
outside their themes.
Action
1 Select a theme, layer or sub layer from the table of contents and hold on to it
using the left mouse button.
2 Drag the theme, layer or sub layer to the desired position in the table of contents.
3 Release the theme, layer or sub layer in the desired position.
The map is adapted on the basis of the position of the map layer.
Also view:
Adjusting the transparency of a map layer
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Displaying active elements of a legend

Description
A map layer contains elements which are symbolized in the map. The description of
the symbols is displayed in the legend when a map layer is marked ‘visible’ in the
table of contents.
Action
 To view the legend, click the ‘Legend’ tab next to the ‘Themes’ tab at the table of
contents.
Also view:
Map layer visible in the legend
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Adapting the scale

Description
The scale level can be adapted by means of zooming in and out. Zooming occurs
step-by-step. The steps were set in advance and cannot be adapted. The scale level
is visible at the bottom of the map in an entry box. This value can be adapted
manually by entering a different number. The map is adapted in conformity with the
scale number entered.
Action

1 Click in the entry box at the bottom of the map as shown in the illustration.
2 Enter a new scale number.
3 Press ‘Enter’ to confirm the scale number.
The map is adapted in conformity with the new scale number.
Also view:





Zooming in on the map
Zooming out on the map
Retrieving scale information on an active map layer
Notification of the visibility of a scale-dependent map layer
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Displaying cursor coordinates

Description
The X and Y coordinates of the cursor (when the cursor is in the map) are visible at
the bottom of the map in entry boxes. These boxes cannot be adapted manually.
The X and Y coordinates are adapted when the mouse moves the cursor in the map.
The coordinates are displayed in latitude en longitude according to the WGS84
coordinate system.
Action
No action.
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Scale ruler

Description
The scale ruler is to be found at the bottom left of the map. It represents the scale
in relation to the map. The scale rule is represented in kilometres in case of
extensive zooming out, the scale rule is represented in metres in case of extensive
zooming in.

Action
No action.
Also view:





Zooming in on the map
Zooming out on the map
Retrieving scale information on an active map layer
Notification of the visibility of a scale-dependent map layer
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Maximizing a map window

Description
A defined space has been reserved for the map window. It is possible to enlarge the
displayed map window and to return it to its original size.
Action

1 Click the displayed buttons.
The map window is enlarged when panels of the application are folded in. These
panels can be folded out again through the buttons, so all the functions are usable
again.
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Opening map settings

Description
A file of map settings may contain the following: labels, selections, map layers, redlining and the zoom level. Several map settings can be stored. This file is loaded
when logging in. A file of map settings can be opened from a location on a hard disk
or network station.
Opening a map setting from a location on a hard disk or a network station:
1
2
3
4

Select the ‘This computer’ tab.
Click ‘Browse’ to find the desired map-settings file (xml).
Click ‘Open’.
A pop-up window appears in which the user can choose if the layers are to be
synchronized with the current layer-settings of the administrator.
5 If 'no' is selected, the window is closed and the settings of the opened file are
loaded.
6 If ‘yes’ is selected, a new pop-up window appears in which the user is informed
on which map layers, present in the settings file, will be added but are (no
longer) part of the administrators settings. Also, the user is informed on which
map layers are present in the administrator’s settings but missing in the selected
settings file. If desired, the user can select these map files to be added as well
when the map layers are loaded.
7 Select ‘Add’ to add the map layers.
Also view:
Saving map settings
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Saving map settings

Description
A map-settings file (xml) may contain the following: labels, selections, map layers,
red-lining and the zoom level. Several map settings can be stored.
Action

1
2
3
4
5

Go to the ‘File’ tab.
Click the displayed button (a window pops up).
Select an existing folder or enter the name of a new folder.
Click ‘Save’.
Click ‘Close’.

The window is closed and the settings are stored in a new xml file.

Overwrite an existing file.
1 Select an existing file in the list.
1 Click ‘Save’.
1 Confirm this action by selecting ‘Yes’.
1 Click ‘Close’.
The window is closed and the settings are stored in the selected xml file.
Also view:
Opening map settings
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Printing maps

Description
A map can be printed or saved to a file (pdf).
When printing the map, a legend, title and north arrow will be added tot the map.
Action

1 Select the ‘File’ tab.
2 Click the ‘print’ button to open up the ‘print’ pop up window
3 Add or select the following information from a dropdown list:
 Title: Title of the map (optional)
 Layout: Select a map layout
 Scale: Select a print scale
 Rotation: Rotation (degrees) to the map (default = 0°)
1 To reset the extent (and scale) of the map, select the reset position (reset pos.)
button. A transparent square will appear in the map. Click on the square to move
it to another position or rescale the map extent.
2 Click the Print button to create a pdf file of the map
3 A new window appears with a link to open the pdf file
4 Click on the link an open the pdf file in a new window using Adobe Acrobat
5 Print or save the pdf file using the Adobe Acrobat tools.
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Selecting by means of clicking

Description
This selection tool makes it possible to select features in the map by means of
clicking objects in the map. When a selection has been created, it can be used. The
selection table, for example, shows what was selected. Only features from active
map layers can be selected.
Action

1 Go to the ‘Select’ tab.
2 Click the displayed button.
3 Select an object in the map by clicking it.
The selected object (based on the active sub layer(s)) are marked.
Also view:







Selecting with the use of a rectangle
Selecting by drawing a line
Selecting by drawing a polygon
Using the selection table
Cancelling a selection
Activating a map layer
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Cancelling a selection

Description
A previously created selection of features can be cancelled by means of this
functionality. This function deletes all current selections at any map layer.
Action

1 Go to the ‘Select’ tab.
2 Click the displayed button.
The selected features are deselected.
Also view:







Selecting by means of clicking
Selecting with the use of a rectangle
Selecting by drawing a line
Selecting by drawing a polygon
Using the selection table
Activating a map layer
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Selecting with the use of a rectangle

Description
This selection tool makes it possible to select features in the map by means of
drawing a rectangle. When a selection has been created, it can be used. The
selection table, for example, shows what was selected. Only features from an active
map layer can be selected.
Action

1 Go to the ‘Select’ tab.
2 Click the displayed button.
3 Keep the left mouse button pressed in and draw a rectangle around the features
to be selected.
The selected objects (based on the active

sub

layers) are marked.

Also view:







Selecting by means of clicking
Selecting by drawing a line
Selecting by drawing a polygon
Using the selection table
Cancelling a selection
Activating a map layer
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Selecting by drawing a line

Description
This selection tool makes it possible to features in the map by drawing a line. When
a selection has been created, it can be used. The selection table, for example,
shows what was selected. Only features from an active map layer can be selected.
Action

1
2
3
4

Go to the ‘Select’ tab.
Click the displayed button.
Draw a line by placing dots in the map.
Double-click in the map to finish drawing the line.

The features touched (based on the active

sublayers) are marked.

Also view:







Selecting by means of clicking
Selecting with the use of a rectangle
Selecting by drawing a polygon
Using the selection table
Cancelling a selection
Activating a map layer
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Selecting by drawing a polygon

Description
This selection tool makes it possible to select features in the map by drawing a
polygon. When a selection has been created, it can be used. The selection table, for
example, shows what was selected. Only features from an active map layer can be
selected.
Action

1
2
3
4

Go to the ‘Select’ tab.
Click the displayed button.
Draw a polygon by placing dots in the map.
Double-click in the map to finish the drawing of a polygon.

The features touched (based on the active

sub

layer(s)) are marked.

Also view:







Selecting by means of clicking
Selecting with the use of a rectangle
Selecting by drawing a line
Using the selection table
Cancelling a selection
Activating a map layer
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Selecting inside another geographical feature

Description
This selection tool makes it possible to select features within a map layer ‘Y’ using a
selected feature from another map layer ‘X’. Map layer ‘X’ should contain polygon
features.
Action

1
2
3
4
5
6

Activate map layer 'X'
Go to the ‘Select’ tab.
Select a feature from map layer 'X' in the map by clicking it.
Click the displayed button to open the selection pop up window.
Select a sub layer from map layer 'Y' from the map layer dropdown lost.
Choose a selection colour, used to identify the selected features in the map
(optional).
7 Click the OK button to perform the selection
8 Click the Close button to close the selection window
Selected features (based on the active sub layers) are marked.
Also view:








Selecting by means of clicking
Selecting with the use of a rectangle
Selecting by drawing a line
Selecting by drawing a polygon
Using the selection table
Cancelling a selection
Activating a map layer
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Query builder

Description
The query builder enables the selection of geographic features on the basis of a
query consisting of one or more expressions that can be combined. An expression
comprises an attribute, an operator and a value. Attributes are the non-spatial
features of a geographic object, for example the name of the object. The operator
indicates what the value of the attribute has to comply with. The operators available
are: equals (=), does not equal (!=), is smaller than (<), is smaller than or equals
(<=), is larger than (>), is larger than or equals (>=), or contains (LIKE).
An example: all the objects dating back to before the year 1500 can be retrieved
with the query First Year Dated < 1500.
The query builder can only be used after activating the map layer to be queried has
occurred.
In MACHU-GIS all sub layers of an activated layer will be included in the query. To
query a single sub layer, activate only this sub layer in the table of contents.
Action

1
2
3
4
5

Go to the ‘Select’ tab.
Click the displayed button to open the 'Query builder' window.
Select an attribute from the attribute dropdown list.
Select an operator from the operator dropdown list.
Enter a selection value. By using the ‘..’ button, a limited number of example
values will be selected from the active map layer. To add an example value,
select it from the example values dropdown list.
6 Click the Add button to combine the selected components of the query to a query
expression.
7 Repeat previous steps to add another expression to the query (optional)
Click

to delete an expression.

The expression appears in a table. If the entire expression must be denied, this is
indicated by ticking in the ‘Not’ column of this table. The 'And/or' column of this
table offers the opportunity to indicate how the expression must be combined
with the next expression. This is done by clicking in the cell of the ‘And/or’
column. Attribute, operator and value can be changed here by clicking it and
changing its content.
The complete query appears in the text box below the table, where the
expressions are displayed.
8 Choose a selection colour, used to identify the selected features in the map
(optional).
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9 Select 'Execute query' to carry out the query,
10 Select 'Clear' to delete the entire query.

or

After executing the query one can
1 Use the Zoom to selection button to zoom to the selected features in the map or
2 Open the selection table button to view the attribute information of the selected
features in the selection table.
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Using the selection table

Description
The selection table contains attribute information of the active map layer.
If no selection has been performed on the active map layer, the table will contain
attribute information on all available features within this map layer. If a selection is
performed on the active map layer, the table will contain only attribute information
on the selected set of features. Use the remove selection button at the select tab to
delete any selection.
Additional functionalities are available which are related to the selection table. These
functionalities become available as soon as the selection table is opened:
: When using the Open Attribute Table button at the bottom of the table of contents
instead, this will open the attribute table showing all available features within a sub
layer, regardless of any selection! The result of the additional functions within this
table however, will still be performed on the selected set of features (if present).
Action

The selection table can be opened if a selection has been created in an active
sublayer.
1 Go to the ‘Select’ tab.
2 Click the displayed button.
A window pops up containing attribute information of the selected features in the
shape of a table (or all features if no selection is performed). Within the table, the
following functions are available:

Highlighting object(s)

1. Select one or more rows (simultaneously press the 'Shift' or ‘Crtl’
key when clicking more rows) to create a sub selection.
1 Click the displayed button.
The selected features are highlighted in the map.

Zooming to a selection
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1 Click the displayed button.
Zooming occurs to all features. However if a sub selection is created, zooming will
occur only to the selected set of features.

Exporting to an Excel file

1 Click the displayed button.
1 Click ‘Save’ or ‘Open’ when the request appears to download the Excel file.
The Excel file contains the same values as the attribute table. If a sub selection is
created, only the rows of the sub selection will be exported.

Deleting a sub-selection

If a sub-selection is present, it can be deleted.
1 Click the displayed button.
The sub-selection is removed from the table. The selection remains unchanged.

Sorting records
It is possible to sort the records of the selection table.
1 Select an attribute header. Once a header is selected, an arrow is displayed after
the attribute name and a dropdown list with additional options is added.
1 Click on the arrows after the attribute name to order the record ascending or
descending

or

1 Click the dropdown list and select the option Sort Ascending or Sort descending.

Determine the visibility of attributes
It is possible to determine which attributes in the table are visible.
1 Select an attribute header. Once a header is selected, an arrow is displayed after
the attribute name and a dropdown list with additional options is added.
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1 Click the dropdown list and select the option Columns to open a list of available
attributes.
1 Switching the visibility of attributes on or off is done by ticking the checkboxes in
front of each attribute
Also view
Using the attribute table
Cancelling a selection
Activating a map layer
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Editing labels

Description
A label is a tag showing information on an object in the map. These labels can be
added to the map. Labels can be edited with respect to colour and font, deleted
again and stored in a map settings file.
Action

1
2
3
4
5
6

Go to the ‘Label’ tab.
Click the displayed button (a window pops up).
Select an attribute.
Select a colour.
Select the character size.
Click ‘OK’ to confirm.

The window is closed and the edited labels appear in the map.
Also view:
 Deleting labels
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Deleting labels

Description
If a map layer possesses edited labels, they can be deleted.
Action

1 Activate the layer possessing the labels to be deleted.
2 Click the displayed button.
The labels disappear from the map.
Also view:
Editing labels
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Settings
Description
A User can determine the visibility of available functions within MACHU during a
session.
Action

1 Go to the Setting tab.
2 Click the displayed button (a window pops up).
3 Switching the visibility of functions done by:
 Switching function on or off by ticking the checkboxes in front of each individual
function
 Switching all functions on by clicking the ‘restore default functions’ button or the
‘show all functions.‘ button
1 Click the Close button to close the window.The functions will be visible according
to the settings.
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Report
Description
This function is added to MACHU GIS to create a possibility to report new cultural
heritage features for MACHU according to the MACHU data formats. This function
opens up a link to a website, managed by the Dutch MACHU partner, the Cultural
Heritage Agency (Rijksdienst voor het Cultureel Erfgoed).
Action

1 Go to the Report tab.
2 Click the displayed button to open up the website.
3 Follow the instructions on the website.
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Contact information
Description
Questions or remarks on the MACHU GIS viewer can be posted tot the
administrator.
Action
1 Click ‘Contact’ in the top right header of the application.
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Help
Description
Find help on the functionalityof MACHU GIS.
Action

1 Click Help in the top right header of the application or click the displayed button.
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Adapting the character size

Description
It is possible to adapt the font size of the application in the table of content, button
information and the content of pop up windows.
Action
 Select the desired font size by clicking the ‘a’ of the relevant size in the top right
header of the application. The bold letter indicates which character size is active.
The size of the first one is 11pt, the second is 13pt and the third 16pt.
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ISO 19115:2003

In accordance with INSPIRE guidelines, the MACHU-GIS uses the ISO19915:2003
metadata standard for geography. Because of the development and maintenance of
MACHU-GIS by Rijkswaterstaat, the metadata in MACHU is displayed according to
the Dutch profile on ISO19915:2003, which contains the core set of the European
profile set by INSPIRE.
You will find more information on European metadata standards for geography and
web services on the website of INSPIRE. For information on the Dutch meta data
profile, visit the website of Geonovum.
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Explanation of the fields

Explanation of the meta data fields according to meta data standard ISO
19115:2003.
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Metadata file identifier

Unique ID for the meta-data file. It is created with the use of the Global Unique
Identifier.
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Metadata language

What language is used to describe the meta data? Entering the correct language
occurs with abbreviations. ‘dut’ is the standard indication for Dutch. Other
examples: English ‘eng’, German ‘gem’, French ‘fre’. For a complete list of
abbreviations please go to:http://www.loc.gov/standards/iso6392/php/code_list.php
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Metadata character set

Full name of the character encoding standard to describe the meta-data set. The
encoding standard tells a computer which characters (letters, numbers, punctuation
marks, etc.) a document is composed of: the bytes are translated into the correct
characters and vice versa. This is a conditionally compulsory box: it is compulsory if
the value of the character set is not in compliance with the ISO/IEC 10646-1. The
standard is ‘utf8’, which stands for '8-bit variable size UCS Transfer Format, based
on ISO/IEC 10646'. Because this code complies with ISO/IEC 10646, this box
becomes optional.
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Parent Id

Unique ID for the meta data of which these meta data are a subset. It is created by
the use of the Global Unique Identifier and is generated automatically.

Page 71 of 159

Help text MACHU-GIS | 22 2 2013

49

Metadata hierarchy level

On which data level is the meta data applicable (from low to high)? 4 data levels are
to be distinguished:
 Attribute; is applicable to one feature, examples are: meta data with respect to
the position, meta data with respect to the elevation data, meta data with respect
to the concentration (as an attribute is never described on its own, this data level
cannot be selected).
 Data set; is applicable to one collection of data which are connected in a certain
way, examples are: topographic map 1:10,000 vector edition of December 2006,
aerial photograph of a province included in the first quarter of 2005, depth
gauging data of a harbour included in January 2007.
 Series; is applicable to a number of data sets, examples are: topographic map
1:10,000 vector editions of 1990 up to and including 2006, aerial photographs of
provinces, included in 2000, 2002, 2005, 2007, depth gauging data of harbours,
included in 1990, 1994, 1998, 2003, 2007.
 Service; is applicable to a (web)service with one or more data sets or series (a
different ISO standard is used for the meta-data description of a service).
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Hierarchy level description

If the metadata are not applicable to (one complete) data set, but a series is, this
constitutes a deviating situation and this is an element to be entered compulsorily.
In case of a data-set series an adequate description must be entered to which the
meta data are applicable.
Examples are:
 Is applicable to all grid data sets within the (map-page) top25grid series.
 Is applicable to all polygon data sets of the digital topographic map 1:10,000
vector edition of 2006.
 Is applicable to all grid data sets within the aerial photograph 2006 15 cm
resolution series.

Page 73 of 159

Help text MACHU-GIS | 22 2 2013

51

Contact responsible party metadata

Name/address data in meta data of contact point
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Responsible party meta data

Name of the organization or person responsible for the correctness of the contents
of these meta data. Taking the 'Role of the organization' box into account is
important in this respect, for this box indicates that the organization is also a
contact point. When entering this item, use the full name of the (department within
the) organization and, if applicable, followed by the official abbreviations of the
department or organization (between brackets).
Examples are:
 Rijkswaterstaat, Ministry of Transport, Public Works and Water Management
(RWS) Data-ICT-Department (DID).
 Topografische Dienst Kadaster (Ordnance Survey).
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URL of metadata organization

Website address of the organization or person responsible for the contents of these
meta data.
Examples are:
http://www.rijkswaterstaat.nl
http://www.kadaster.nl
http://www.zeeland.nl.
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Metadata date

This date indicates the up-to-date ness of these meta data. The date is entered
automatically at the moment of creation of these meta data. When the meta data
are changed afterwards, the date is automatically adjusted, so the up-to-date ness
of these meta data remains correct. The date is displayed like this: YYYY-MM-DD
(2007-12-31).
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Metadata standard name

Name of the meta-data standard used. This box is automatically filled with the
current international ISO standard for meta data: ‘ISO 19115:2003’.
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Metadata standard version

Name of a selection profile of the ‘ISO 19115:2003’ meta-data elements. Within The
Netherlands this profile is called ‘Nederlandse meta data standaard voor geografie
1.1’ (abbreviated to ‘NL profile’) and it is binding for the Dutch national government.

This profile is used to display meta information in MACHU GIS.
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Dataset title

A unique and identifying name for the data set or data-set series.

Examples are:





Address Coordinates The Netherlands (ACN) edition 2007.
Depth gauging data Vlakte van de Raan period 1 up to and incl. 15 January 2007.
Dredging and pouring sections Westerschelde 2007 as per 1-01-2007.
Kerngis road areas The Netherlands survey date 1-03-2007.
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Alternative title

Translation of the data set into a different language or an addition to the data-set
title (sub-title). In most cases a title is meant here indicating how the file is known
in popular speech or else the official abbreviation of the file (e.g.. AHN5*5, TOP10,
DTB, NWB and the like).
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Dataset reference date

This concerns the reference date of the related data set. The format of the date is
YYYY-MM-DD (hyphenated). The type of event the date refers to is indicated in the
linked 'Date of creation, publication or modification' box (related data-set reference
date) (ISO no. 395)'. The information to be entered in this field must indicate
whether the creation, a publication or a modification of this related data set is
concerned.
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Date of creation, publication or modification

Event to which the date is related. Possible events are: Date of completion
(Creation), Date of publication and Date of latest modification (Revision). The
choices have the following definitions:
Creation = Date on which the data set or data-set series was created.
Publication = Date on which the data set or data-set series was published.
Revision = Date on which the data set or data-set series was checked, corrected or
modified.
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Version

Version number or version name
In a number of cases files which are kept up to date on a regular basis are indicated
with a year in their data-set name, e.g. 'Aerial photograph 2007'. In most cases the
version is not indicated in the data-set title. In all cases the version number or
version name must be submitted here, so also including an additional specification
when for instance a half-yearly or quarterly delivery is concerned, e.g. '2007 2nd
quarter' or '2008 1st half year'. It is less common to indicate a GIS file used
organization-wide or within several organizations by a version number such as ‘1.1'
or '35' (as is usual with Word and Excel files (and the like)), although it may be
advisable for specific file types, such as a depth-gauging file (grid file) of a (part of
a) river branch or sea channel which is updated on a weekly basis (in this case the
meaning of the version number must have been documented). In case of depthgauging files it is also customary to submit a date (and time, if applicable) as a
version number, e.g. '18aug07'.
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Citation identifier code

Unique value to describe data, so each meta-data file is unique. Code is generated
automatically.
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Series name/number

Name of the series or derived data set, of which the data set is a part. A data set
has a name for the main theme, e.g. 'DTB' (Digital Topographic Dataset). Usually
this main theme is divided into one or more sub-themes or series, e.g. 'DTBwet' and
'DTBdry'. The moment when a correction or renewal is implemented in the data
structure, the serial name and/or serial number is usually changed as well. E.g.
'DTBwet' and 'DTBdry', which are joined into a new serial name ‘DTB2000’ by means
of an adjustment in the file structure. Another example is topographic files of the
Topografische Dienst Kadaster (Ordnance Survey). The main theme is the common
topographic files ('TOP'), the various serial names consist of e.g. 'TOP250grid',
'TOP50grid', 'TOP50vector', 'TOP10vector'(old), 'TOP10NL' (new).
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Abstract

Enter an extensive description of the contents and meaning of the data set, this
may deal with the geographic component as well as the attribute values, with the
creation of the data set (series as well as with the (tips for the) use of the data set
now and in the future.
Examples are:
 Address Coordinates The Netherlands comprises every known Dutch postal
address, provided with an x- and a y-coordinate, measured in the National
Triangulation System.
 The soil map contains information on the composition of the soil up to a depth of
approximately 1 metre. Groundwater steps (Gts) provide information on the
depth of on average the highest (GHG) and on average the lowest groundwater
level (GLG)
The summary is also intended to incorporate each form of description that cannot be
described in any other box. An example of this is a description of the period when
obtaining data for the production of the data set was started and finished (such as
the period of flying to take aerial photographs for or the production of the end
product or an end product derived from this), with the period of obtaining those
data being outside (before) the time frame of the temporal coverage of the data set.
A second example is an indication of the box(es) which can be used to display labels
and legend(s). A third example is a description of the number of records (number of
polygons, lines or points) occurring in the data set, an indication whether the
features are single-part or multi-part, an indication of the modifications, i.e. how
many and which, if applicable, have been changed in comparison with a previous
version of the file. Furthermore, the summary is important to indicate which
data/objects may be incorrect, for example because data were obtained whose
quality is (partly) doubtful.
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Purpose of the creation

Purpose for which the data were originally created or intended. This may be, for
example, 'topographic reference image scale 1: 25,000', 'aerial-photo reference
image up to scale 1:1,000', 'reference image up to scale 1: 500 as basis for
digitalization of management objects', 'depth gauging to determine the Nederrijn
channel depth', 'file serves as Dredging Reference Plane for the Waal from 01-012008', 'to determine main routes in The Netherlands', etc. If the data set was
specifically created for a project, it is advisable to describe this clearly here including
the project name, project number (and other relevant file numbers, if any),
description of the project (or a description of the location where information on the
project is to be found) and the specific relation between data set and project.
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Status

Status of editing or revision and use of data set or data-set series. Options:







Update required. (Data are still to be updated/created).
Planned. (Data are planned for update or creation).
Under development. (Data are being created).
Completed. (Data are ready, production is concluded).
Continuously updated. (Data are constantly revised to keep them up to date).
Historical Archive. (Data are stored in records which are not immediately
accessible).
 Not relevant (Data are no longer relevant and consequently unusable).
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Example

File name of a figure showing a sample image of the data set. Various extensions
(file types) are possible, it is advisable to display the entire route (internet link) to
the server, so it can be opened by clicking the button.
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Responsible party dataset

Name of the organization or person responsible for the correctness of the contents
of this data set or data-set series. It is of importance to take the following box into
account: 'Role of the organization', for this box indicates that the organization is
also a contact point. Please enter the full name of the (department within the)
organization, followed, if applicable, by the official abbreviations of the department
or organization (between brackets). Examples are: Rijkswaterstaat, Ministry of
Transport, Public Works and Water Management (RWS) Data-ICT-Department (DID)
and Topografische Dienst Kadaster (Ordnance Survey).
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Role of the responsible party

As a rule ‘Contact point’ is entered here, or ‘The organization or person to be
contacted to gather know-how on or supply of the data set(s)’.
Roles are:
 Supplier - Organization supplying the data.
 Manager – Party that accepted responsibility for and takes care of the
management of the data.
 Proprietor – Party that owns the data.
 User – Party that uses the data.
 Distributor – Party involved with the delivery of the data set.
 Maker – Party that created the data.
 Contact point – Party that can be contacted to gather know-how or to supply the
data.
 Obtainer – Key party responsible for gathering data and performing research.
 Editor – Party that edited the data, in such a way that the data have changed.
 Publisher – Party that publishes the data.
 Author – Party that is the author of the data.
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URL of responsible party dataset

Website address of the organization or person responsible for the contents of this
data set or data-set series.
Examples are:
http://www.Rijkswaterstaat.nl,
http://www.kadaster.nl,
http://www.zeeland.nl.
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Keywords

Keywords are words which are commonly used and give a quick indication of the
contents of a data set. Besides, keywords are used as search terms to find data sets
within a digital databank.
Examples are:
Archaeology, Address coordinates, Postal addresses, Soil map, Geology, Depth data,
Fauna, Flora, Boundaries administrative, Boundaries cadastral, Boundaries nature,
Groundwater, Elevation data, Infrastructure, Aerial photography, Environmental
data, Planning, Spatial use, Satellite images, Topography general, Topography
organization-specific, Permits, Traffic data.
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Thesaurus of keywords

Reference to a domain (thesaurus) which uses particular keywords and gives them
meaning. E.g. GEMET - GEneral Multilingual Environmental Thesaurus, (European
Environment Agency) at http://www.eionet.europa.eu/gemet/.
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Spatial resolution

The scale to which the file may be truthfully used. Using a larger scale (more detail)
than the applicable scale furnishes information which may seem correct, but
contains a (light or strong degree of) inaccuracy that is usually not visible. A scale is
as truthful as the scale to which the data in the data set were obtained, with the
exception of data sets the same accurately obtained data of which have been
generalized to a less detailed scale level. In this exceptional case the degree of
generalization also determines the scale level of the data set.
Example: Where policy assistants want to be reasonably sure of the locations of
houses and buildings in relation to the distance of a motorway route, they can make
use of a large-scale file (e.g. scale 1:1,000) such as the GBKN (large-scale standard
map of The Netherlands), the Land Registry Office or the DTB (Digital Topographic
File). A consultant looking for a mapped overall survey of buildings on a national
level makes use of a small-scale file displaying merely a generalized outline of a
village or urban buildings (e.g. a topographic file on scale 1: 250,000). Note: so
scale 1:1,000 is larger than a scale 1: 250,000.
Exclusively positive numeric numbers must be entered, examples are:
1000 = 1 in 1,000 (1 cm = 10 m)
10000 = 1 in 10,000 (1 cm = 100 m)
25000 = 1 in 25,000 (1 cm = 250 m)
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Dataset language

What language is used to describe the data set? This concerns the texts in the boxes
and the definitions of the attribute table. Entering the correct language occurs using
abbreviations. ‘Dut’ has been entered for Dutch. Other examples are: English ‘eng’,
German ‘gem’ , French ‘fre’. For a complete list of abbreviations please go to:
http://www.loc.gov/standards/iso639-2/php/code_list.php
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Dataset character set

Full name of the character encoding standard used to describe the data set. The
encoding standard tells a computer which characters (letters, numbers, punctuation
marks, etc.) a document is composed of: the bytes are translated into the correct
characters and vice versa. This is a conditionally compulsory box; it is compulsory if
the value of the character set is not in compliance with ISO/IEC 10646-1.
The standard is 'utf8', which stands for '8-bit variable size UCS Transfer Format,
based on ISO/IEC 10646'. As this code complies with ISO/IEC 10646, this box is
optional.
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Topic categories

Main theme(s) of the data set. For example: ‘elevation’ for General Elevation File
The Netherlands (AHN) or ‘location’ for Address Coordinates The Netherlands (ACN).
Select from the options below:

Agriculture and cattle Livestock farming or growing plants. For example:
breeding
agriculture, irrigation, diseases affecting crops.
Biota
Flora and fauna in their natural environments. For
example: habitats, ecology.
Boundaries
Area descriptions with legal status. For example: habitat
guideline for areas, Flora & Fauna Act for areas, political
and administrative boundaries.
Climatology,
Processes and phenomena in the atmosphere. For
meteorology,
example: cloud cover, weather, climate change.
atmosphere
Elevation
Elevation information, both on land and under water. For
example: laser altimetry, depth gauging, elevation map,
DEM, slopes.
Nature and
Natural sources, protection and management. For
environment
example: environmental pollution, countryside, water
quality, waste storage.
Geoscientific data
Data belonging to an earth science. For example:
geology, minerals, structure of the earth, gravity map,
raw materials, erosion.
Health
Health (care), human ecology and security. For example:
diseases, hygiene, health care.
Reference material on Basic maps. For example: land coverage, topographic
earth coverage
maps, (aerial) photographs, unclassified maps.
Military
Sensitive military information such as bases, structures
and activities. For example: barracks, warehouses, drill
grounds, military transports.
Location
Positional information and services. For example:
addresses, geodetic network, postcodes and postcode
areas, place names, checkpoints.
Oceans
Information on areas with salt-water bodies (not in-land).
For example: tides, coastal information.
Planning land register Information used for planning activities. For example:
land use, cadastral information.
Society
Characteristics of society and cultures. For example:
anthropology, archaeology, crime, customary practices,
settlements, education.
(Civil) structures
Structures made by humans. For example: dams, bridges,
sluices, museums, churches, shops, towers.
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Transport

Means of transport of goods and/or persons. For
example: waterways, railways, roads, airports, tunnels.
Utility companies and Infrastructure and facilities. For example: power cables,
communication
water mains, gas mains, water purification,
telecommunication, radio, TV.
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Supplemental information

Additional information with respect to the data, for example documentation. One or
more references to documentation can be included here (e.g. an ISBN number),
maybe as an internet link, describing additional information on the data set.
Examples are:
MER A50/A73 rapport, isbn :..
http://www.ahn.nl
https://vergunningen.rws.nl/vergunningen
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Name of related data set

Group of connected data sets which have not been defined as a 'data-set series'.
This usually concerns project and planning studies and implementation projects.
Examples of linked (related) data sets are: 'PKB Space for the River (Key Planning
Decision Space)', Framework Directive Water', 'Planning Study A28', 'Dredge project
..', 'KernGIS', 'Spatial Policy'.
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Reference date of related data set

The reference date of the related data set is concerned here. The format of the date
is YYYY-MM-DD (hyphenated). The type of event the date refers to is displayed in
the box linked to it: 'Date of creation, publication or modification (Reference date of
related data set) (ISO no. 395)'. The entry in this box must indicate whether the
creation, a publication or a modification of this related data set is concerned here.
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Type of relation

Type of relation between the data sets. This relation is always indicated by the term
‘Cross-reference’ and is also the only option to be used in this ISO standard. The
user is not required to enter anything here.
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Data set of contact point

Name/address data of a contact point.
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Usage

Brief description of the possibilities for use. Besides 'Purpose of the creation' there
are often several options for use of the data set. An example is a boundaries file
serving as an official administrative boundary (with a rather high degree of accuracy
of 1:10,000), while at the same time, in an A3 map with the entire Netherlands, this
file may also serve as a small-scale reference file or survey map.
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Organization using the data

Identification or means to get into contact with other users of the data. Contact data
of users other than meta data and those responsible for the data.
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Constraints

Applications for which the data are not suitable in a GIS-technically specific sense
and/or for which use of the data is not even allowed. It is not the intention to
mention all the applications for which the data are not suitable in a general sense.
Examples are:
 Not to be used with a scale larger (more detailed) than 1: 50,000.
 To be used for rural area, not suitable for existing urban area.
 Using data for Navigation is not allowed.
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(Legal) access constraints

Access requirements intended to ensure that the privacy or intellectual property of
an external party remains safeguarded and all the other restrictions with respect to
obtaining both the meta data and the data. If data and meta data are freely
accessible, the notification ‘Not applicable’ is compulsory. Select an option from the
list with the following access restrictions:

Not
applicable
Copyright

Freely accessible, there are no legal restrictions on use.

Legally not freely accessible, the rights for publication, production
and sale of rights is vested in an external party. Written consent for
use is required by definition. However, conditions are usually
made public stating the way in which it is permitted to publish the
data set without written consent.
Patent
Legally not freely accessible, concerns produced or sold
pending
information waiting for a patent. Written consent prior to use is
required.
Patent
Legally not freely accessible, produced or sold information is
patented by the authorities. Written consent prior to use is
required.
Brand name Legally not freely accessible. Is officially registered and its use is
strictly reserved to its proprietor or manufacturer.
Licence
Legally not freely accessible. Under certain conditions the
authorities have a licence. Written consent prior to use is usually
required.
Intellectual Legally not freely accessible. Is the property of an external party,
property
comparable with copyrights. Written consent prior to use is
required.
Other
Deviating restrictions exist. Contact the organization concerned
restrictions prior to use.
Not
Total prohibition on distribution and use.
accessible
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Legal use constraints

Requirements for use safeguarding privacy or intellectual property and any other
special restrictions with respect to obtaining the meta data or data. The options
have the following definitions:

Copyright

Patent

Exclusive right to publication, production or sale of rights to a
literary, theatre, musical or artistic work, or to the use of a
commercial edition or label, granted by law for a specific period
of time to an author, composer, artist or distributor.
Authorities have granted an exclusive right to create, sell, use or
license an invention.
Information produced or sold and waiting for a patent.

Patent
pending
Brand name A name, symbol or other object to identify a product, which has
been officially registered and the use of which is legally reserved
to its proprietor or manufacturer.
Licence
Formal consent to do something.
Intellectual Right to financial benefit of and having control over the
property
distribution of an intangible property which is the result of
creativity.
Not
Prohibition on distribution and use.
accessible
Otherwise Restriction not included in the list (use the ‘Other restrictions
(ISO no. 72)’ box to explain this option in more depth).
A 'Copyright' usually applies for GIS files obtained from another organization, and
the option ‘Otherwise’ usually applies for files from one’s own organization.
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Other constraints

Other restrictions or limitations which cannot be entered in other boxes, for example
compulsory acknowledgement of the source or the name of the copyright holder.
Furthermore, if the option ‘Otherwise’ has been selected with the ‘(Legal)
restrictions preventing use (ISO no. 71)’ box, this option must be explained in more
detail here. A possible definition may be 'No legal restrictions preventing use'.
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Security constraints

Restriction imposed because in principle the information is confidential. The options
have the following definitions:

Freely
Available for general disclosure.
accessible
Not accessible Not suitable for general disclosure.
Confidential Available to persons capable of dealing with the information in
a confidential manner.
Secret
Must be kept secret and concealed to everyone except a selected
group of persons.
Top secret
Strictest secrecy mandatory.
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User note

Explanation referring to the security restrictions. Also view the explanation 'Security
restrictions (ISO no. 74)'. In order to create a better understanding of the reasons
why files are ‘Confidential’ or ‘Not accessible’ (or (‘Top) ‘Secret'), this is the place to
enter specifically whether ‘Private property protection’ or ‘news-sensitive
information' and the like is concerned.
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Lineage level description

The level referred to by the data-quality description. Options are:
 Data set: refers to one data set.
 Series: refers to several data sets consequently constituting a series.
 Service: refers to a service rather than to a data set/series.
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Completeness value unit

Entry of the unit of the numeric value entered in the 'Completeness (ISO no. 137)'
box, for example: per cent, mm, cm, m. If a textual description instead of a numeric
value is entered with quantitative value, the value ‘text’ must be entered in this box.
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Completeness

Indication whether the data set is complete. This concerns both the completeness of
the geometry and the attribute data of the geometry. A numeric indication with a
measuring unit in percentages is sufficient here, for example: 10, 90, 100. But it
can also be done in another textual manner, this is by far the clearest way to
describe completeness, for example: 11 provinces completed, 10 out of 90 map
pages are completed, southern provinces are lacking, attribute data for municipal
roads are lacking.
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Positional accuracy value unit

Entry of the unit of the numeric value entered in the 'Geometric accuracy (ISO no.
137)' box, for example: mm, cm, m, hm, km. Within GIS cm (large-scale, accurate
files) or m (small-scale files) are usually taken as the unit. If a textual description
instead of a numeric value is entered with quantitative value, the value ‘text’ must
be entered in this box.
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Positional accuracy

Maximum numeric value of the deviation of the x and y coordinates in the data set
in relation to the actual place on earth. If the deviation is in a range (for example 0
to 5 cm), the highest deviation must be entered (5 cm). If necessary, the deviation
can be entered textually too. Accuracy is also indicated using the term systematic
error. This in contrast to the term accidental error which is used for precision.
Among other things accuracy is dependent on the manner of obtaining the data.
Data obtained terrestrially (by means of land surveying) are of a higher accuracy
than data obtained photogrammetrically (based on aerial photographs).
Furthermore the equipment used (e.g. kind of GPS receiver) and the reference files
used (e.g. quality of aerial photographs on which digitalizing occurs) play a
significant role with respect to accuracy. Point of departure is an accuracy of 0.2
mm, related to the original map scale [Source: Object catalogue GBKN (large-scale
standard map of The Netherlands). A description of the minimum contents of the
GBKN, National Partnership GBKN, Apeldoorn, September 1998]. When digitalizing
at a map scale of 1:10,000 this results in a maximum deviation of 2 m.
 E.g. 'TOP10Vector' > maximum deviation 4 m.
 E.g. 'GBKN' Photogrammetrically obtained > maximum deviation for urban area
(scale 1:1,000) 20 cm, and maximum deviation for rural area (scale 1: 2,000) 40
cm.
 E.g. 'GBKN' Terrestrially obtained > maximum deviation for urban area (scale
1:1,000) 10 cm, and maximum deviation for rural area (scale 1: 2,000) 30 cm.

If the deviation is unknown or cannot be determined, this could be refferd as
‘Not doable’.
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Source description

General description of or comments on the history of a data set if they do not fit the
other meta-data boxes. This may also be descriptions of or comments on the source
data and/or the production process. Descriptions may be extensive. Examples are:
 Postcode table linked to building and plot coordinates on the basis of cadastral
maps.
 Land Registry Office supplies a text file which is converted into a GIS polygon
shape file by the Public Works and Water Management Geo-Information and ICT
Department.
 The National Road File (NWB) is composed from the most current and accurate
source files, such as the Digilanguage Site File 2000 file (DTB2000), and missing
parts are supplemented by the Topographic map 1:10,000 vector (TOP10 Vector)
file of the Topografische Dienst Kadaster (Ordnance Survey).
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Process steps description

The method used to obtain the source data. Also enter applicable regulations, if any.
This offers additional information on the data set.
Examples of methods:
- Multibeam acoustic soundings in accordance with regulations by the Directorate
-General for Public Works and Water Management (RWS) of January 2007.
- Laser altimetry height measurements in accordance with regulations by the
Rijkswaterstaat, Ministry of Transport, Public Works and Water Management (RWS)
of February 2007.
- Visual observations in the field.

Method of obtaining 1 Levelled points
Method of obtaining 2 Remote sensing
Method of obtaining 3 Aerial photographs
Method of obtaining 4 Aerial photographs false colour
Method of obtaining 5 Multibeam
Method of obtaining 6 Laser altimetry
Method of obtaining 7 High points from aerial photographs
Method of obtaining 8 Ground radar
Method of obtaining 9 Single-beam echo sounder
Method of obtaining 10 Terrestrially measured points
Method of obtaining 11 Contour lines from aerial photographs
Method of obtaining 12 Sub-bottom profiler
Method of obtaining 13 GIS edits
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Date of processing

Date on or period during which the source data were obtained. If several activities
took place, the period lasts up to the date of the next activity.
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Processing organization

Name/address data of the organization that performed the edits to the data set.
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Data source description

Description of the background history of a data set: the origin of the data in the
data set, the organization that created it. In many cases a description of the full
name of the source data and the up-to-date ness of the source data suffice to
supply the desired information: 'Cadastral plots version supply January 2007'.
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Data collection description

The method used to obtain the source data. Also enter the applicable regulations, if
any. This offers additional information on the data set.
Examples of methods:
 Multibeam acoustic soundings in accordance with regulations by the
Rijkswaterstaat, Ministry of Transport, Public Works and Water Management
(RWS) of January 2007.
 Laser altimetry height measurements in accordance with regulations by the
Rijkswaterstaat, Ministry of Transport, Public Works and Water Management
(RWS) of February 2007.
 Visual observations in the field.

Method of obtaining 1 Levelled points
Method of obtaining 2 Remote sensing
Method of obtaining 3 Aerial photographs
Method of obtaining 4 Aerial photographs false colour
Method of obtaining 5 Multibeam
Method of obtaining 6 Laser altimetry
Method of obtaining 7 High points from aerial photographs
Method of obtaining 8 Ground radar
Method of obtaining 9 Single-beam echo sounder
Method of obtaining 10 Terrestrially measured points
Method of obtaining 11 Contour lines from aerial photographs
Method of obtaining 12 Sub-bottom profiler
Method of obtaining 13 GIS edits
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Time/period of data collection

Date on or period during which the source data were obtained. If several activities
took place, the period lasts up to the date of the next activity.
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Responsible party dataset

Name of the organization that obtained the source data. Taking the ‘Role of the
organization’ (next box) into account is of importance in this respect. Don’t use
abbreviations only. Make use of the options list. Examples are: Rijkswaterstaat,
Ministry of Transport, Public Works and Water Management (RWS) Data-ICT-Dienst
(DID), Topografische Dienst Kadaster (Ordnance Survey).

Page 126 of 159

Help text MACHU-GIS | 22 2 2013

103

Revision frequency

Frequency of revising the data. In case of small data sets the entire set is usually
revised at this frequency, in case of large area-, land-covering data sets only those
map pages (different arrangement, if applicable) in which the data have changed
are revised and supplied with this frequency. Options:

Continuously
Data are updated repeatedly and frequently.
Daily
Data are updated each day.
Weekly
Data are updated each week.
Biweekly
Data are updated every 2 weeks.
Monthly
Data are updated each month.
1 x quarterly
Data are updated once each three months.
1 x semi-annually
Data are updated every six months.
Annually
Data are updated each year.
2-,3-,4-,5-,6-,7-,8-,9-yearly Data are updated once every .. years.
10-yearly
Data are not updated within 10 years.
Over 10-yearly
Data are updated once in more than 10 years.
If required
Data are updated if necessary.
Irregularly
Data are updated at intervals of different lengths.
Not planned
There are no plans to update the data.
Unknown
Revision frequency is not known.
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Date of next revision

Planned date of next revision of the data. The planned date must be in accordance
with the 'Revision frequency' (box 143).
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Spatial representation type

Method used to present the geographic information spatially.

Vector Data consist of vectors used to create geometric elements such as
points, lines and polygons.
Grid
Data consist of a collection of cells of the same size and shape, with
each cell having a value applying to the area of the entire cell.
Text
Data in the shape of a text or table.
table
TIN
Data in this Triangulated Irregular Network consist of nodes and lines
describing a surface as a collection of irregular triangles with an x-, yand z-coordinate on each point (node) of the triangles. The TIN is a 3dimensional model.
Stereo Data providing a 3D overview with the aid of two overlapping images.
model
Video Data consisting of video images.
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Reference system code

The (alphanumeric) encoding for the reference system (coordinate system) applying
to the position data (x, y) in the data set. A code from the EPSG (European
Petroleum Survey Group) standard must be used to name the reference system. A
horizontal and vertical reference system combination is also possible, i.e. 7415, the
combination of RD New and NAP (provided the vertical reference system actually is
NAP).
In MACHU GIS, datasets are preferably provided in the WGS84.
Examples and features of this and other systems are:

EPSG Reference system
Feature
28992 RD New
(projection)
7415 RD New / NAP
(composition)
4937 ETRS 89
(geographic 3D)
25831 ETRS 89 / UTM zone 31N (projection)
3447 ETRS 89 / Lambert 2005 (projection)
4326 WGS 84
(geographic 2D)
4979 WGS 84
(geographic 3D)
4230 ED 50
(geographic 2D)
23095 ED 50 / TM 5 NE
(projection)
23031 ED 50 / UTM zone 31N (projection)
23032 ED 50 / UTM zone 32N (projection)
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Responsible party namespace referenceschema

Name of the organization responsible for the codes of reference systems. E.g.
‘European Petroleum Survey Group (EPSG)’ which is responsible for the EPSG codes.
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Name of object catalogue

Name of the object catalogue. In an object catalogue the definitions are given of all
kinds of objects (object classes) and the attributes explained. If the object catalogue
has not been stored with the data set, a URL can be entered here as well.
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Object catalogue reference date

The reference date of the object catalogue is concerned here. The format of the date
is YYYY-MM-DD (hyphenated). The type of event referred to by the date is 'Creation,
publication, or modification date (Data on Object catalogue) (ISO no. 395)'. It must
indicate whether the creation, a publication or a modification of this related data set
is concerned here.
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Distribution format

Name of the file format with which the data are distributed. Examples are: Shape,
Feature Class, File System Grid (ESRI Grid), GML, DWG, DXF, Ascii, DBF.
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Version of distribution format

Version number or version name of the distribution format. To be able to determine
whether data can be used in an application, it is necessary to know the version of
the file format in which the data are supplied. Examples are: DGN_V8, DXF_R14,
DXF_R2000, DXF_R2004, DXF_R2006, DXF_R2007, DWG_R14, DWG_R2000, DWG
_R2004, DWG _R2006, DWG _R2007.
Comment: GIS file types do not possess versions in distribution format.
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Contact distributor

Contact information, provide by the distributor of a dataset.
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Name of distributing organization

Name of the organization or person responsible for the distribution of this data set
or data-set series. Please enter the full name of the (department within the)
organization, followed, if applicable, by the official abbreviations of the department
or organization (between brackets). Rijkswaterstaat, Ministry of Transport, Public
Works and Water Management (RWS) Data-ICT-Dienst (DID) is the standard entry
as most of the data supplies for the Rijkswaterstaat, Ministry of Transport, Public
Works and Water Management (RWS) are issued by them.
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Role of distributing organization

The role or function of the organization here is always ‘Distributor’, in accordance
with the ISO standard defined as ‘The organization or person taking care of the
supply of the data set’.
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URL of distributing organization

Website of the organization or person taking care of the supplies of the data set or
data set series (distribution). Examples are: http://www.Rijkswaterstaat.nl,
http://www.kadaster.nl, http://www.zeeland.nl.

Page 139 of 159

Help text MACHU-GIS | 22 2 2013

116

Distribution order process fees

Amount required to obtain the data, including the currency unit. Please enter the
amount first, followed by the correct currency. Abbreviations for the currency are
the standard three-letter codes in accordance with ISO 4217. For example: 100 EUR
or 145 USD.
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Distribution order ordering instructions

General instructions and conditions applied by the organization with the supply of
data.
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Distribution order process turnaround

The time required for the supply of data, from the moment of commencement by
the client. For example: 5 working days or 3 weeks.
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Distribution/usage unit

Manner in which the data are supplied, for example: supply per map page, supply
per province, supply per year, supply per country, per boundary to be indicated
individually in digital form in RD projection.
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File size

The file size is the size of the file of data to be expected in Megabyte(s), of one unit
as specified in the box ‘Supply/utility unit’. The size must exceed 0 (zero). The
abbreviation for Megabyte is MB.
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URL of dataset

The location of the data set including the name of the server, for example:
\\servernaam\gisdata\bodem\bodemtype.shp.
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Name of medium

Name of the kind of medium on which the data can be supplied, or the kind of direct
connection through which the data are available.
For example: CD-ROM, DVD, Memory card, Hard disk, the Internet, Satellite. More
than one option is possible.
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Name of application schema

The name of an application diagram or information model if the data set has been
composed according to that diagram. Examples are: IMRO2005, TOP10NL, IMWA. A
diagram entered here must be in conformity with ISO 19109.
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Application schema reference date

Reference date of the application diagram. The format of the date is YYYY-MM-DD
(hyphenated). The type of event referred to by the date is displayed in the box
linked to it ‘Date of creation, publication or modification (date of application
diagram) (ISO no. 395)'. It must indicate that the creation, a publication or a
modification of this related data set is concerned here.
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Application schema language

Identification of the computer language in which the definition of the diagram has
been drawn up.
Example: GML, UML, NEN3610, IMRO2005.
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Application schema constraint language

Identification of the computer language used to describe the application diagram.
Example: OCL.

Page 150 of 159

Help text MACHU-GIS | 22 2 2013

127

Extent description

Textual description of the period referred to by the data of the data set, in other
words the period during which the data are valid. This element applies if a data set
is not continuous and the data or objects in the data set may vary per period. In
that case the data or objects in the data set represent a moment in time. For
example a water boundary during a flood, or area boundaries with legal validity for
a particular period only. In principle each data set has a temporal coverage which is
valid up to the next revision of the data set. Examples are:





01-01-2007 up to and incl. 31-12 2007
Period 1999-2001, during working days (Monday up to and incl. Friday).
Weeks 30, 31, 35, 36 in 2007, during the time of 02:00 and 05:00 (p.m.).
Maximum flood boundary 29 up to and incl. 31 January 1995.

Page 151 of 159

Help text MACHU-GIS | 22 2 2013

128

Geografic area description

Name of the geographic area covered by the data. Several area categories are to be
distinguished, such as the name of the whole or part of the country, province,
municipality, region, water board, water area, water body, coastal strip, beach,
dune area, polder, river foreland, dyke body, brook-valley area, wildlife area,
national park, (national) countryside, sand-drift area, peat area, lateral-moraine
area, economic region, agricultural region, urban area, border area, industrial area,
military area, airport, (sea)port area, recreational area, ruined area.
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West bound longitude

Extremely western coordinate (left side of surrounding rectangle) in the horizontal
coverage of the data set. Coordinate according to the reference system WGS 84. (If
possible) the value for this box is automatically calculated and entered from the
data set. Manner of entering and display is degrees with decimals: 51.80 (N) or
3.70 (E).
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East bound longitude

Extremely eastern coordinate (right side of surrounding rectangle) of the horizontal
coverage of the data set. Coordinate according to the reference system WGS 84. (If
possible) the value for this box is automatically calculated and entered from the
data set. Manner of entering and display is degrees with decimals: 51.80 (N) or
3.70 (E).
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South bound longitude

Extremely southern coordinate (bottom of surrounding rectangle) of the horizontal
coverage of the data set. Coordinate according to the reference system WGS 84. (If
possible) the value for this box is automatically calculated and entered from the
data set. Manner of entering and display is degrees with decimals: 51.80 (N) or
3.70 (E).
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North bound longitude

Extremely northern coordinate (top of surrounding rectangle) of the horizontal
coverage of the data set. Coordinate according to the reference system WGS 84. (If
possible) the value for this box is automatically calculated and entered from the
data set. Manner of entering and display is degrees with decimals: 51.80 (N) or
3.70 (E).
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Temporal extent

Validity of the contents of the data in a data set or data-set series specified by an
end date. If the data apply during a specific period of time, the starting and final
dates of this period should be entered here. Manner of entering and display is:
YYYY-MM-DD -YYYY-MM-DD (2007-01-01 -2007-12-31).
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Minimum value

Lowest vertical value in the data set, e.g. in LAT (Lowest Astronomical Tide) and in
a unit of metres
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Maximum value

Highest vertical value in the data set , e.g.in LAT (Lowest Astronomical Tide) and in
a unit of metres
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